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package BrowserVersionDescription is
-- I
--INote: All Browser source code will be located in the directory:
-- I geech$duaO:[incrl.boeing.ql2.cdrl4lO.Browser] on the Boeing Wichita

repository after 17-March-1989.

*ICSCI Architecture

-- I The Ada static architecture of the Browser is depicted in figure 1. There
-- I are seven packages and the calling procedure (or driver). Each package
-- I encapsulates a group of logically related operations (or subprograms).

-- The compilation order for the units are:

STRING UTILITIES -- Provides operations on strings
-- (in files string utilities_.ada,
-- I strinq utilities.ada)

-- BROWSERTYPES -- Package containing common type dearA+-ins
-- I in tiles browser_Types_.ada, BrowserTypes.ada)

MACHINE OPS -- Package containing machine dependent operations
-- (in files Machine_Ops_.ada, Machine_Ops.ada)

FILEOPS -- Package containing file i o operations
-- I -(in files File_Ops_.ada, file_Ops.ada)

EXTRACT OPS -- Package containing the operations for the search
-- I functions of the Browser (in files Extract_Ops_.ada,
--I Extract_Ops.ada)

MENU OPS -- Package containing the operations for the menu
functions of the Browser (in files Menu_Ops_.ada,
enuOps.ada)

BROWSER OPS -- Package containing the executive typc operations for
--I the Browser (in files BrowserOps_.ada,
--I Browser_Ops.ada)

BROWSERDRIVER -- This is the main calling procedure for the Browser
-- j(in file BrowserDriver.ada)
--- II
--IVirtual Interfaces

There are no virtual interfaces for this tool.

--ITool Interfaces
Browser does not interface with any other tool. The Browser interfaces
with the user through procedures in TEXTIO package (ie. getline,

-- I put_line).

--IHardware Interfaces
-- I The Browser requires an ASCII terminal. This Browser version was developed

to operate on a VAX operating system (ver. 4.7). The VAX dependent
--. operations are grouped in the Machine Ops package and may be easily

modified to operate under another operating system.
-- I
--IFunctional Control and Data Flow
-- I The purpose of the Browser tool is to provide a non-VMS means of viewing
-- I VMS directories and VMS files. To navigate through any combination of

I possible VMS directory structures (directed graphs), the Browser uses the
recursion feature of Ada. As the user descends down a directory
structure, the Browser will call itself to present the user with a menu

-- fcrmatted display screen of the contents of the currern. directory. As the
-- user ascends back up the directory structure, the precious directory is

redisplayed.



* Browser Package Structure
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Figure 1

Diagrams From: Software Components With Ada, Structures, Tools, and Subsystems,
Grady Booch, 1987



-- I The Browser does not move the users VMS directory default position.
-- In-stead, the Browser maintains a Virtual Path variable that contains the

VMS directory path for the current directory being displayed.
-- I
-- I The Browser presents the user with a menu formatted screen of a VMS

-- I directory by:
1) creating a file (in a specified 'utility' directory) that contains a

directnry listing of the user specified directory
2) reading from that file the contents of the directory
3) placing each file/subdirectory name into a linked list

-- 4) deleting that file in the utility directory

-- I The Browser uses the linked list of file/subdirectory names to present
-- I these names to the user in a menu format. When the user

chooses from the menu a file name, the Browser will allow the user to
edit that file. When the user exits the edit session, the same menu is
displayed to the user. When the user chooses from the menu a

-- I subdirectory, the Browser uses a recursive call to generate a new linked
-- I list for that subdirectory. By using the recursion feature in this way,

the linked lists of previous directories viewed by the user arp not
de-referenced, and therefore do not have to be re-cenerated. Tli. op

-- I course is only true for users current directed path, and not for previous
--I directed paths.

The Browser does require two files to exist before the Browser will
-- I execute. These files are:

1) Menu 1 - This file contains a list of the top level commands
that the user may want to perform. An example of this file follows.

.. This is the first menu for the stars foundation

.. Browser tool. ** Make certain that this file remains version 1!
-- (Do not delete these first three lines. Program dependent.)
Review STARS Foundation Projects

--I Help
-- I or 'X' to Exit (Return to MAIN MENU)

.. (Do not delete these last two lines. Program Dependent.)

These commands are parsed in the procedure
BrowserOps.Execute MainChoice. To change, or add capabilities to this
menu, see this procedure.

-- 2) Menu 2 - This file is a listing (dir/col=l) of the top level
directory that will be browsed. The purpose of this file is to allow the
top level file names, and sub directories to be annotated with a brief
explanation of the contents oT the file/subdirectory. Here is an example
of a Menu_2 file:

...-- 1 This is the second menu for the stars foundation

....-- 2 Browser tool. ** Make certain that this file remains version 1!
-.3 (Do not delete these first three lines. Program dependent.)
ADSYSTECH.DIR;l -Ada Run-Time Support Services (ARTS)
AETECH VI.DIR;l -Rapid search and Retrieval (RSR)
BDM.DIR;l -Secure File Transfer System

-- CSC.DIR;l -TransparentSequentialIO, & Ada Types Library
....-- i

-.2 (Do not delete these last two lines. Program Dependent.)

*z To create such a file, follow these VMS commands:

-- I dir/col=l/output=usr$dsk:ftop levellmenu_2.dat usr$dsk:[top_leveldir]
-- edit menu 2.dat
--I .. add annotations

remove any files that you don't want the user to browse at top
level



exit the editor
-- I purge usr$dsk:[top level dir]menu 2.dat

-- rename usr$dsk:[top level dirmenu 2.dat;2 -
-- usr$dsk:[top_level_dTr]menu 2.dat;l

The procedure that calls the Browser, BrowserDriver.ada, specifies all
of the menu names and their locations.

-- I (STLDD 3.4)
--- I
-- System Environment
-- I The Browser was developed in Ada, and targeted to the VAX OS Version
-- 4.7. The Browser does 'with' the following VAX predefined package:

-- LIB -- Declarations of types, routines and return statuses for the
-- General Purpose (LIB) facility of the VAX/VMS Run-Time
-- Library.

-- I System Parameters
-- I The parameters that the installers/users will supply are found in the
-- I procedure BrowserDriver. These parameters are:

----

-- I TopLevel Dir -- The top level directory to start browsing.

Menu_1_Title -- The screen title that you want displayed for menu 1.
-- I
-- I Menu_1 -- The complete path name, file name for the first menu to
-- I be displayed.

Menu 2 Title -- The screen title that you want displayed for menu 2.

Menu_2 -- The complete path name, file name for the second menu
to be displayed.

-- I Editor -- Editor that the user will use.

-- UtilityDirectory -- The directory that will be used for file operations
-- I described in the FunctionalControl andDataFlow section
-- I of this document.

- - - - - - - - - - - -

Reference CDRL410 for an example of how these parameters are declared and
-- I defined.
-- I

-- ISystem_Capacities
-- I Browser requires 227 blocks of storage space for the source code. The
-- I Browser is not memory intensive.
---- I
--- Installation Instructions

The initial version (1) of the Browser was designed to run on the VAX
-- I version 4.7. To install this Browser tool on you system, simply copy the
-- I source code to your directory, create an ACS library, and compile and link
-- I it. To create the DEC ACS Ada library use a command similar to:

$ ACS CREATE LIBRARY USR$DSK:[YOURDIR.ADALIB]

After setting to this library,

$ ACS SET LIBRARY USR$DSK:[YOURDIR.ADALIB]

-- users can submit a batch file that has the following commands for
-- compiling the Browser routines.

-- $ ada String Utilities
-- $ ada String-Utilities



-- $ ada Browser_Types_
-- $ ada Machine_Ops_
-- $ ada Machine_Ops
-- $ ada File Ops_
-- $ ada FileOps

$ ada Extract Ops
$ ada ExtractOps

-- $ ada Menu Ops_
-- $ ada Menu_Ops
-- $ ada Browser_Ops_
-- $ ada Browser_Ops
-- $ ada Browser Driver
-- $ link BrowserDriver

$ exit

Before the Browser Driver can be run, the user must create the two menu
files that are required for the Browser to run successfully. See the

-- I functional control and data flow section of this document for
instructions on hoW to-creae these files.

-- ~ There is one more file that is used for the 'escape to VMS' function of
the Browser. The escape to VMS function allows the user to temporarily

-- I visit a VMS session. When the user browses a directory and wants to use a
VMS command, they can exit the Browser and be placed into the directory

-- I they were viewing. This can be done at any time, and into any directory.
Users have available to them all of the valid (non-privileged) VMS

-- I commands. They can move freely through the directories available. When
-- I the user is ready, they will return to the same Browser screen they saw
-- I when they left. To accomplish this operation, the Browser tool calls a

VMS command file called VMS.COM. This VMS.COM file will be delivered with
-- I the Ada source code in CDRL410. This file may be used as is, or modified
-- I to meet additional needs. It does not require any compilation or other

O-- j preprocessing. It must reside in the 'utilities directory' as defined in
the calling argument to the procedure Browser-Driver.

--- II
--lInventory_of_CSCIContents

-- UnitType UnitName FileName(s)

-- procedure Browser Driver Browser Driver .ada
-- package BrowserOps Browser Ops_.a~a,
-- I Browser_Ops.ada
-- package Browser_Types Browser_Types_ .ada,
-- I Browser_Types.ada
-- package Extract_Ops Extract_Ops_.ada,
-- ExtractOps.ada
-- package FileOps File Ops _.ada,
-- I File Ops.ada
-- package MachineOps MachTne_Ops_.ada,
-- I MachineOps.ada
-- package Menu_Ops MenuOps_.ada,
-- I Menu Ops.ada
-- package StringUtilities StringUtilities .ada,
--I StringUtilities.ada
-- VMS command file VMS.com

-- II
--lAdaptation Data
-- I Once the-two menu files have been created and the Browser Driver has been
-- compiled and linked, and the VMS.com file is in the 'utillty directory',

the user need only run the Browser driver executable.

-- ILessonsLearned

-- 1 1) The following routines in the LIB package were very useful for
-- I executing a VAX Operating System command from an Ada program:



-- I Lib.Spawn - this routine will transfer control to the VAX OS and
-- I execute a specified VMS command, then return control back to .ne Ada

program and continue.

Lib.Do Command - this routine will transfer control to the VAX OS and
execute a specified VMS command. It will not return to the Ada program.

2) In order to temporarily leave an Ada program, and allow the user to
enter a VMS session, the VMS 'inquire' command can be used. The inquire
statement can be placed inside a loop to trap users VMS commands. The
loop is exited when the users satisfies an 'exit loop conditional'. The
following VMS commands are an example of this inquire-in-loop process.

-- (The VMS.COM command file delivered in CDRL410 is based on this example.)

-- $ ready: !loop id
-- $ inquire/nopunctuation next "Browser $" !get users VMS command
-- $ if next .eqs. "DONE" then goto isdone !exit loop when DONE
-- $ if next .eqs. "EXIT" then goto isdone !exit loop when EXIT

$ if next .eqs. "X" then goto isdone !exit loop when X
--I $!
-- $ define/user mode/NOLOG sys$input sys$command
-- $ set control=y

$ on controly then continue
$ on severe error then continue
$ 'next' !execute users command

-- $ set nocontrol=y
1 $ goto ready !goto ready

-- $ isdone:
$ exit !exit this command file

--- I
O- Revision History

-1 Part Number:
-- Author: Charles Elsner (316) 526-4661
-- Version: 1.0;
-- I Change Summary: Initial Release

Date: 6-March-89
--- II
-- IDistribution and Copyright
-- I This prologue must be included in all copies of this software.
-- I This software is released to the Ada community.
-- I lhis softwere is released to the Public Domain (Note:
-- software released to the Public Dontain is nct subjo:t
-- I to copyright protection).
-- I Restrictions on use or distribution: NONE

-- IDisclaimer
This software and its documentation are provided "AS IS" and
without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
for a particular purpose exist.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for
-- I a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user
-- I must assume the entire risk and liability of using this

*-i software.

-- In no event shall any person or organization of people Lt
-- I held responsible for any direct, indirect, consequential

or inconsequential damages or lost profits.
- - I Iend Browser VersionDes cription;



-- I I



package String_Utili*4es is

--I Description
-- This pa&7.ge contains string operations.

-- I Requirements Satisfied
-- I This package does not meet any specific STARS requirements.

-- I

Exceptions Raised

-- I None.

-- I Contact
-- I Charles Elsner
-- I Boeing Military Airplane
-- I 3801 S. Oliver (Ms K80-13)
-- I Wichita, KS 67277

Implementation Dependencies and Assumptions:
-- I Currently, this package uses some of the predefined types from package
-- I Standard.

Revision History
-- I Part Number:
-- Author: Charles Elsner
-- I Version: 1.0;
-- Change Summary: Initial Release
-- I Date: 20-FEB-89

Distribution and Copyright
This Prologue must be included in all copies of this software.

-- I This software is released to the Ada community.
-- I This software is released to the Public Domain (Note: software released
-- I to the Public Domain is not subject to copyright protection).

Restrictions on use or distribution: NONE

-- I Disclaimer
-- I This software and its documentation are provided "AS IS" and

without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

-- I Because of the diversity of conditions and hardware under
which this software may be used, no warranty of fitness for

-- I a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user

must assume the entire risk and liability of using the software.

-- I In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential
-- I or inconsequential damages or lost profits.

function First NonBlankCharacterPosition (In String : string)
return natural;

Description
This function returns the first non blank character position in

-- I a string.
-- I o

function Last Non Blank Character Position (In String : string)



return natural;

--I Description
-- I This function returns the last non blank character position in
-- I d string.-I I. function RemoveLeading_AndTrailing_Blanks (From String : string)

-si -return string;-- I Description

This function removes leading and trailing blanks from a string.
-- I I

function File Type Is (In-String : string) return string;
--I Description
-- I This function returns the file type of a vms file.
-- II

flincticn Full File Name (InString : string) return string;
--I Description
-- I This function returns the complete vms file name less the version.
-- I I

function Just File Name (In String : string) return string;
--I Description -
-- I This file returns the file name minus the type and version.
-- I I

function Back Off (In-String : string) return string;
--I Description
-- I This function removes the last directory in a VMS path name.
-- I ex. New Path := Back Off("geech$dua0:[top.next]");

texY io.put lineTNewPath);.- geecE$duaO:Ttop]

function ToUpper (Input : string) return string;
-- I Description

This function returns a string in upper case.

function SkipUntil (Some String : in string;
UntilChar : in character) return natural;-- I Description

--4 Scan the string until either the end of string is found or the
-- I specified character is found. Return the number of characters
-- I skipped. If the character was not found, return a value of 0.
-- I I

end StringUtilities;



package body StringUtilities is
--I Description
-- I This package contains string operations.
-- I

Sri Requirements Satisfied
This package does not meet any specific STARS requirements.

--- I
Exceptions Raised

-- I None.
-- I
-- I Contact
-- I Charles Llsner

Boeing Military Airplane
3801 S. Oliver (ms K80-13)

-- I Wichita, KS 67277
--- I

-- I Implementation Dependencies and Assumptions:
Currently, this package uses some of the predefined types from package

-- I Standard.

-- I Revision History
Part Number:

-- I Author: Charles Elsner
-- I Version: 1.0;

Change Summary: InitialRelease
Date: 20-FEB-89

-- II
-JDistribution and Copyright

This Prologue must be included in all copies of this software.
-- I This software is released to the Ada community.

This software is released to the Public Domain (Note: software released
to the Public Domain is not subject to copyright protection).

Restrictions on use or distribution: NONE

Disclaimer
This software and its documentation are provided "AS IS" ind
without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
for a particular purpose exists.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for

a particular purpose is offered. The user is advised to test
the software thoroughly before relying on it. The user

-- I must assume the entire risk and liability of using the software.

In no event shall any person or organization of people be
held responsible for any direct, indirect, consequential
or inconsequential damages or lost profits.

function FirstNonBlankCharacterPosition (In String : string)

. ... return natural is-- I Description
This function returns the first non blank character position in

-- I a string.
-- I I



Count : natural;
begin

for Index in In String'range loop
Count :- Inaex;
exit when InString (Count) /s '

end loop;

return Count;
end First Non Blank CharacterPosition;

function LastNonBlankCharacterPosition (In-String string)
return natural is

Description
This function returns the last non blank character position in
a string.

-- II

Count : natural;
begin

for Index in reverse In String'range loop
Count := Index;
exit when InString (Count) /5 ,

end loop;

return Count;
end LastNonBlankCharacterPosition;

function Remove Leading_And TrailingBlanks (From String string)
e-- -- return string isW --I Description

-- I This function removes leading and trailing blanks from a string.
-- I

begin
return From String

(First Non Blank Character Position (From String)
Last 'Ron Blank Character Position (FromString));

end RemoveLeading_And_Trailing_Blanks;-

f,. -tion File TypeIs (InString : string) return string is
Description

-- I This function returns the file type of a vms file.
-- II

Count2, Countl : natural := 0;
begin

for Index in InString'range loop
Countl := Index;
exit when InString(countl)

end loop;

for Index in Countl..InString'last loop
Count2 := Index;
exit when (InString(Count2) ';') or (In_String(Count2) '

end loop;

return In String( (Countl + 1)..(Count2 - 1));
end FileTypeIs;

- - - - asnasinnasflsaasinasa=



function Full File Name (In-String : string) return string is
-- I Description
-- I This function returns the complete vms file name less the version.
-- I I

Countl natural := 0;
begin

for Index in In String'range loop
Countl := Index;
exit when InString(Countl) =

end loop;

return In String(l..(Countl - 1));
end FullFileName;

function Just File Name (In-String : string) return string is
--I Description

This file returns the file name minus the type and version.
-- II

Countl : natural := 0;
begin

for Index in In String'range loop
Countl := Index;
exit when In String(Countl) =

end loop;

return In String(l..(Countl - 1));
end JustFile_Name;

function Back Off ( InString : string) return string is
Description

-- I This function removes the last directory in a VMS path name.
ex. New Path :- Back Off("geech$dua0:[top.nextl");

-- I texf io.put lineTNewPath);
-- geech$duaO:Ttop]
-- I

Countl : natural := 0;

begin
for Index in reverse InString'range loop

Countl :- Index;
exit when InString(Countl) =

end loop;

return (In String(In String'first..(Countl - 1)) & "]");
end BackOff;

function ToUpper (Input : string) return string is. -- I Description
This function returns a string in upper case.

Temp : string (Input'range) :- Input;
Interval : integer :- character'pos('a') - character'pos('A');

begin
for I in Input'range loop



if (Input (i) >= 'a') and (Input(i) <- 'z') then
Temp(i) :- character'val(character'pos(Input(i)) - Interval);

end if;
end loop;
return Temp;

* end To_Upper;

function Skip_Until (Some String : in string;
Until Char : in character) return natural is-- I Description

-- f Scan the string until either the end of string is found or the
--j specified character is found. Return the number of characters
-- I skipped. If the character was not found, return a value of 0.
-- I I

Index : natural SomeString'first;
Found : Boolean false;

begin
while Index <= Some String'last loop

if Some String(Index) = UntilChar then
Foun3 := True;
exit;

end if;

Index := Index + 1;

end loop;

if Found then
return (Index);

else
return (0);

end if;

end Skip_Until;

end StringUtilities;



with text io;
with CondTtionHandling;

package Browser_Types is
Description

*- This package contains the type declarations for the Browser operations.

-- I
Requirements Satisfied

This package does not meet any specific STARS requirements.
--- I

-- I Exceptions Raised

-- I None.

-- I Contact
-- Charles Elsner

Boeing Military Airplane
-- 3801 S. Oliver (ms K80-13)
-- I Wichita, KS 67277

Implementation Dependencies and Assumptions:
-- I Currently, this package uses some of the predefined types from package
-- I Standard.

Revision History
Part Number:

-- I Author: Charles Elsner
-- I Version: 1.0;

.-- Change Summary: Initial-Release
Date: 20-FEB-89

-- I
-- Distribution and Copyright
-- I This Prologue must be included in all copies of this software.
-- I This software is released to the Ada community.
-- I This software is released to the Public Domain (Note: software released
-- I to the Public Domain is not subject to copyright protection).

Restrictions on use or distribution: NONE

-- I Disclaimer
-- I This software and its documentation are provided "AS IS" and
-- I without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

-- ~ Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for
-- ~ a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user
-- must assume the entire risk and liability of using the software.

-- 1 In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential
-- I or inconsequential damages or lost profits.

*ype String_AccessType is access string;

type Menu Line Type;
type Menu -ListType is access MenuLine_Type;
type Menu LineType is
record



Line : String Access Type;
Next : MenuList_Type :- null;

end record;

subtype Cond Value_Type is Condition Handling.CondValue_Type;
isplayHeight : constant natural :-24;

eisplayWidth : constant natural :- 80;

--exceptions here

Menu To Wide : exception;
FileCantOpen : exception;

--generics here

package IntIo is new text io.integer io (integer);

end BrowserTypes;



with BrowserTypes;

package Machine_Ops is
--I Description

This package contains the visible operations on the object Machine.
All of the procedures/functions in this package are machine dependent.
They run on the VAX version 4.7.

-- I
-- I Requirements Satisfied

This package does not meet any specific STARS requirements.
--- I

Exceptions Raised

-- I None.
--- I
--I Contact
-- I Charles Elsner

Boeing Military Airplane
-- I 3801 S. Oliver (ms K80-13)
-- ~ Wichita, KS 67277
--- I

-- ~ Implementation Dependencies and Assumptions:
-- I Currently, this package uses some of the predefined types from package
--I Standard.

Revision History
-- f Part Number:
-- I Author: Charles Elsner

* Version: 1.0;
Change Summary: Initial-Release
Date: 20-FEB-89

--- II
-- I Distribution and Copyright

This Prologue must be included in all copies of this software.
-- I This software is released to the Ada community.
-- ( This software is released to the Public Domain (Note: software released
-- I to the Public Domain is not subject to copyright protection).

Restrictions on use or distribution: NONE

-- I Disclaimer
This software and its documentation are provided "AS IS" and

-- ~ without any expressed or implied warranties whatsoever.
-- I

No warranties as to performance, merchantability, or fitness
-- I for a rarticular purpose exists.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for
-- a particular purpose is offered. The user is advised to test

the software thoroughly before relying on it. The user
-- must assume the entire risk and liability of using the software.

-- I In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential
-- or inconsequential damages or lost profits.

procedure DoCommand (Status : out Browser_Types.CondValueType;
In String : in string);

-- I Description c-- I This procedure calls the lib.do command.
-- I



procedure Spawn (Status : out Browser_Types.CondValue_Type;
InString : in string);-- I Description

-- I This procedure calls the spawn command.S--I I

procedure Turn Off Mess;
--I Description

This command turns off the messages to the screen.
-- II

procedure Turn On Mess;
-- I Description
-- I This command turns on the messages to the screen.
-- i

end MachineOps;



with Lib;

package body MachineOps is
--I Description

This package contains the hidden operations on the object Machine.
O- All of the procedures/functions in this package are machine dependent.

WI They run on the VAX.

Requirements Satisfied
-- I This package does not meet any specific STARS requirements.
-- I
--1 Exceptions Raised
-- Nne.

-- Contact
-- j Charles Elsner
--j Boeing Military Airplane

3801 S. Oliver (ms K80-13)
-- I Wichita, KS 67277

Implementation Dependencies and Assumptions:
-- I Currently, this package uses some of the predefined types from package
-- I Standard.

Revision History
Part Number:

-- I Author: Charles Elsner
.iI Version: 1.0;

Change Summary: Initial Release
Date: 20-FEB-89

--- II
-- I Distribution and Copyright
-- I This Prologue must be included in all copies of this software.
-- I This software is released to the Ada community.
-- I This software is released to the Public Domain (Note: software released
-- I to the Public Domain is not subject to copyright protection).
-- I Restrictions on use or distribution: NONE

-- I Disclaimer
This software and its documentation are provided "AS IS" and

-- I without any expressed or implied warranties whatsoever.

--j No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

-- I Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for

a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user
-- I must assume the entire risk and liability of using the software.

-- I In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential
-- I or inconsequential damages or lost profits.

procedure DoCommand (Status : out Browser Types.Cond_ValueType;
In String : in string) Is-- I Description



--i This procedure calls the lib.do command.
-- it

TempString : Browser_Types.StringAccessType :- new string'(In_String);egin

~Lib.DoCommandStatus,Temp_String.all);

end DoCommand;

procedure Spawn (Status : out Browser Types.CondValue_Type;
InString : in string) is--1 Description

This procedure calls the spawn command.

TempString : browserTypes.String_Access_Type :- new string'(InString);
begin

Lib.Spawn(Status,Temp_String.all);

end Spawn;

procedure Turn OffMess is
--i Description
-- I This command turns off the messages to the screen.
-- il

* tatus : BrowserTypes.CondValueType;

begin

Lib.Spawn(Status,
"Set message/noidentification/noseverity/nofacilicy/notext");

end;

procedure Turn On Mess is
--i Description

This command turns on the messages to the screen.
-- ll

Status : BrowserTypes.CondValue_Type;

begin

Lib. Spawn(Status,
"Set message/identification/severity/facility/text");

end;

end Machine_Ops;



with Text Io;
with Machine Ops;
with String_Utilities;
with Browser Types;

ackage FILE OPS is
W-- Description

This package contains the visible operations for the object File.
--- I

-- Requirements Satisfied
This package does not meet any specific STARS requirements.

--- I

--I Exceptions Raised

--I None.
-- - I

-- I Contact
-- I Charles Elsner
-- I Boeing Military Airplane
--j 3801 S. Oliver (ms K80-13)
-- I Wichita, KS 67277

--- II
Implementation Dependencies and Assumptions:

-- I Currently, this package uses some of the predefined types from package
-- I Standard.

--I Revision History
Part Number:

- IAuthor: Charles Elsner
WI Version: 1.0;

-- I Change Summary: Initial-Release
Date: 20-FEB-89

Distribution and Copyright
This Prologue must be included in all copies of this software.
This software is released to the Ada community.
This software is released to the Public Domain (Note: software released

-- I to the Public Domain is not subject to copyright protection).
Restrictions on use or distribution: NONE

-- I Disclaimer
This software and its documentation are provided "AS IS" and
without any expressed or implied warranties whatsoever.

-- I No warranties as to performance, merchantability, or fitness
-- ~ for a particular purpose exists.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for
-- I a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user

must assume the entire risk and liability of using the software.

In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential

or inconsequential damages or lost profits.

procedure Create Data File(
Utility Dir - : in Browser Types.String_Access_Type;
File Line : in BrowserTypes.StringAccess_Type;
User : in Browser_Types.StringAccessType;



VirtualPath : in out Browser_Types. StringAccess_Type;
File : out BrowserTypes.String_Access_Type);

--I Description
--I This routine creates the vms file containing the directory listing
-- I of vms directory. It also updates the users virtual path (ie. what

I directory the user is currently viewing.)

procedure Edit File
VirtuaT Path : in Browser Types.StringAccessType;
Editor : in BrowserTypes.StringAccess_Type;
Line : in BrowserTypes.String_AccessType);

-- I Description
-- I This routine edits a vms file.
-- I

procedure Add_Options
File : in Text Io.File_Type;
Ptr : out BrowserTypes.Menu ListType;
Number Of Choices : out natural;
Longest_MenuLine : out natural);

Description
-- I This routine reads a vms file and loads them into a linked list.
-- II

procedure Load Menu List
File Name : in string;
Ptr : out BrowserTypes.Menu List-Type;
Data File : in out Text IO.File_Type;
Number Of Choices : out natural,
Longest Menu Line : out natural);

-- I Description
This routine calls the add options routine after determining the file
that contains directory listing.

end FileOps;



package body File_Ops is
--I Description
-- I This package contains the internal operations on the object File.

Requirements Satisfied
W-I This package does not meet any specific STARS requirements.

--- I

Exceptions Raised

None.
--- II
-- I Contact
-- I Charles Elsner

Boeing Military Airplane
3801 S. Oliver (ms K80-13)

-- I Wichita, KS 67277
-- I
-- I

Implementation Dependencies and Assumptions:
-- I Currently, this package uses some of the predefined types from package
-- I Standard.

Revision History
Part Number:
Author: Charles Elsner
Version: 1.0;

-- Change Summary: Initial Release
Date: 20-FEB-89

--- II
-J Distribution and Copyright

W- This Prologue must be included in all copies of this software.
-- I This software is released to the Ada community.
-- I This software is released to the Public Domain (Note: software released
-- I to the Public Domain is not subject to copyright protection).

Restrictions on use or distribution: NONE

Disclaimer
This software and its documentation are provided "AS IS" and

-- I without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for

a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user
-- must assume the entire risk and liability of using the software.

-- I In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential

or inconsequential damages or lost profits.

i rocedure Create Data File(
-Util-ity_Dir : in BrowserTypes.String AccessType;
FileLine : in BrowserTypes.String Access Type;
User : in Browser_Types.StringAccessType;
Virtual-Path : in out Browser_ Types.Sfring_AccessType;
File : out Browser Types.StLingAccessType) is



-- I Description
This routine creates the vms file containing the directory listing
of vms directory. It also updates the users virtual path (ie. what

--H directory the user is currently viewing.)

Temp_File : BrowserTypes.StringAccess_Type;
Status : BrowserTypes.Cond ValueType;
File Name : Browser Types.String Access Type;
TempBuff : string(T..80) := (ot~ers =>- ');

begin

-- get file name
FileName := new STRING'(StringUtilities.JustFileName(FileLine.all));

-- prepare to delete the ']'
Temp_Buff(l..VirtualPath.all'last) :- VirtualPath.all;

-- build virtual path
Virtual Path := new string'(

TempBuff(l..(VirtualPath.all'last - 1)) & "." & FileName.all & "]");

-- file will be in the the utility directory
TempFile := new string'(UtilityDir.all & FileName.all & User.all & ".dat");
File :- TempFile;

-- create data file at the utility directory
Machine_Ops.Spawn(Status,"dir/col=l/output=" &

TempFile.all & " " & VirtualPath.all);

exception
when others =>

null;

end CreateDataFile;

procedure Edit File
VirtualPath : in Browser_Types.StringAccess Type;
Editor : in BrowserTypes.StringAccess-Type;
Line : in BrowserTypes.String_Access_Type) is

--I Description
This routine edits a vms file.

ExecuteString : Browser Types.String Acc-es_Type;
Status : BrowserTypes.Cond ValueType;
FileName : Browser_Types.String_AccessType;

begin

-- get file name
FileName := new STRING'(String_Utilities.FullFileName(line.all));

-- build command string
Execute String := new string'(Editor.all & "/readonly " & Virtual Path.all &

F-ileName.all);

-- edit the file

MachineOps.Spawn(Status,Execute String.all);

end Edit File;



procedure Add_Options
File : in Text Io.FileType;
Ptr : out BrowserTypes.MenuListType;
Number Of Choices : out natural;
LongestMenuLine : out natural) is

Description
This routine reads a vms file and loads them into a linked list.

-- I I
Current :Browser_Types.Menu_ListType;

Back Ptr : Browser_Types.MenuList_Type;
TempLongest : natural := 0;
Temp Choices : natural 0;
One Line : Browser_Types.String_AccessType;
New String : Browser Types.String Access Type;
Buffer : string(T..Browser_Types.display width) :- (others -> '
Test Buffer : string(l..BrowserTypes.display-width) :- (others -> '
Last One : natural := 0;
AddOptionProb : exception;

begin

Current := new Browser_Types.MenuLine_Type;
Back Ptr := Current;
Ptr - Current;

--delete the first three lines
for I in 1..3 loop

if Text Io.End Of File(File) then. Current.Line := new string'("There are no files in this directory.");
Temp_Longest := 37;
Tezmp_Choices 1;

else
text io.skipline(file => File, spacing => 1);

end if;
end loop;

-- read each line from the file
while not text io.end of file (File) loop

textio.get line(iile => File,
item => Buffer,
last => LastOne);

-- if this is the second to last line (ie equal to tempbuffer)
if Buffer - Test Bliffer then

Back Ptr.Next := null;
exit;

end if;

Temp_Choices := Temp_Choices + 1;

OneLine :- new string'(
String_Utilities.RemoveLeading_And_Trailing_Blanks(Buffer));

-- is this the longest one
if Temp Longest < One Line.all'length then

if One Line.all'length > 80 then
TempLongest 80;

else
Temp_Longest := One Line.all'length;

end if;
end if;



Current.Line :- new string'(OneLine.all);

if not text io.end of file (File) then
Current.Next :--ne-w Browser_T~pes.Menu_Line_Type;. Back Ptr :- Current;
Current :- Current.Next;
Buffer(l..Buffer'last) := (others => '

end if;

end loop;

Longest Menu Line := Temp_Longest;
NumberOf Choices := Temp_Choices;

exception
when others =>

raise Add_OptionProb;

end Add_Options;

procedure Load Menu List
File Name - in string;
Ptr : out BrowserTypes.Menu ListType;
Data File in out TextIO.File_Type;
Number Of Choices : out natural;
Longest MenuLine : out natural) is

--I Description
This routine calls the add options routine after determining the file

_- that contains directory listing.-I I

Temp Choices : natural;
TempLongest : natural;
TempPtr : Browser_Types.MenuList_Type;

begin

-- open the data file
begin

text io.open ( file => Data File,
mode => text io.in file,
name => FileName);

exception
when others =>

raise Browser_Types.File_Cant_Open;
end;

AddOptions (DataFile, Temp_Ptr, Temp_Choices, Temp_Longest);

Ptr : TempPtr;
Number Of Choices TempChoices;
Longest_Menu_Line := Temp_Longest;

nd LoadMenuList;

nd File Ops;



with StringUtilities;
with BrcwserTypes;

package ExtractOps is
*- Description

This package contains the visible operations on the object Extract.

--- I
Requirements Satisfied

-- I This package does not meet any specific STARS requirements.

Exceptions Raised

-- I None.
-- I
-- I Contact
-- I Charles Elsner
-- I Boeing Military Airplane
-- I 3801 S. Oliver (ms K80-13)

Wichita, KS 67277
m--

Implementation Dependencies and Assumptions:
Currently, this package uses some of the predefined types from package

-- I Standard.

Revision History
Part Number:
Author: Charles Elsner

-- I Version: 1.0;
@1 Change Summary: Initial-Release

Date: 20-FEB-89

-- Distribution and Copyright
-- I This Prologue must be included in all copies of this software.

This software is released to the Ada community.
-- I This software is released to the Public Domain (Note: software released

to the Public Domain is not subject to copyright protection).
Restrictions on use or distribution: NONE

-- I Disclaimer
-- I This software and its documentation are provided "AS IS" and
-- ~ without any expressed or implied warranties whatsoever.
m--

No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for
-- I a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user

must assume the entire risk and liability of using the software.

In no event shall any person or organization of people be
-- ~ held responsible for any direct, indirect, consequential
-- I or inconsequential damages or lost profits.
-- I

*rocedure Add To Extract Buffer(
-Buffer - : in out string;
Menu Used : in BrowserTypes.MenuListType;
DispTayed : in natural;
Virtual-Path : in BrowserTypes.String_AccessType);-- I Description



-- I This procedure will add one to N file names to a buffer (linked list).
-- lJ

rocedure Write Buffer;
i-i Description-

-~ This procedure writes the buffer to a file in the users directory.
--II

procedure Extract Control;
-- I Description

This procedure is controls the user's interface to the extract
-- I buffer.
-- I
end Extract_Ops;



with Calendar;
with Machine Ops;
with StringUtilities;
with text io;.ith Browser Types;
se Browser Types; -- Using this package to gain visibility to the type

--- declaration operations only;

package body ExtractOps is
--I Description
--I This package contains the hidden operations on the object Extract.
--- I

Requirements Satisfied
-- I This package does not meet any specific STARS requirements.
--- I

Exceptions Raised

--j None.
-- II
-- I Contact
-- I Charles Elsner

Boeing Military Airplane
-- 3801 S. Oliver (ms K80-13)
-- I Wichita, KS 67277

--- II
-- ~ Implementation Dependencies and Assumptions:
-- I Currently, this package uses some of the predefined types from package
-- I Standard.

-1 Revision History
Part Number:

-- I Author: Charles Elsner
Version: 1.0;

-- I Change Summary: Initial-Release
Date: 20-FEB-89

-- I Distribution and Copyright
This Prologue must be included in all copies of this software.

-- I This software is released to the Ada community.
-- I This software is released to the Public Domain (Note: software released

to the Public Domain is not subject to copyright protection).
Restrictions on use or distribution: NONE

-- I Disclaimer
-- I This software and its documentation are provided "AS IS" and

without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
for a particular purpose exists.

-- i Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for
-- I a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user
- - must assume the entire risk and liability of using the software.

*- In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential
--I or inconsequential damages or lost profits.



Head Ptr : BrowserTypes.Menu List Type;
Back-Ptr : BrowserTypes.Menu-ListType;
Number in List : natural;
Longes_ Line : natural;

use Text Io;
procedure HelpExtract is
-- I Description

This is the help screen for the extract operations.
-- II

Buffer : string (1..80);
Length : natural;

begin
-- these io routines are from the Text Io package
new-page;
put line("HELP - ");
new-line;
put line(" This is your Selection Buffer. It contains the ");
put line(" files you have choosen from the menus that you wish");
put line(" to reuse. As you exit this Browser Session, your buffer");
put line(" will automatically be written to your directory. The ");
put line(" file name will be STARS BROWSER current-time.TXT. You");
put-line(" should use this file to-help you remember what units");
put line(" you want to reuse. If your Buffer is empty, nothing");
put line(" will be written to file. To obtain a copy of your");
put line(" selected repository files, the user must use the");
put line(" 'User Request' option available on the STARS Repository");
put line(" menu.");
new-line;
put line(" DE := Delete Entry - If you wish to delete one of the ");
put line(" entries from your list, type DE and the number you");
put line(" wish to delete.");
new line;
put line(" AE := Add Entry - To add an entry, type AE, and answer");
put line(" the prompt with the file you wish to receive.");
new line;
put("press RETURN for more help");
get line (Buffer, Length);
new line;
put line(" CB := Clear Buffer - To delete all entries in your list");
put line(" type CB and return.");
new-line;
put line(" X - This will exit the current menu screen and display the");
put line(" previous menu.");
new-line;
put-line(" RETURN - by itself will either display the next screen in a");
put line(" larger menu, or it will redisplay the same smaller");
put line(" menu. (Larger - more than 18 choices.)");
new-line;
put line(" HELP - This command can be entered any time. This screen ");
put line(" will appear as a result of the help command.");
new line;
new line;
put("press RETURN to continue");
get line (Buffer, Length);

* newpage;

end Help_Extract;

procedure Write Buffer is



-- I Description
-- I This procedure writes the buffer to a file in the users directory.
-- I
rile Name : Browser Types.String Access Type;
irrent Ptr BrowserTypes.Menu LTst Type :- HeadPtr;
ear : calendar.year number;

Month : calendar.montfi number;
Day calendar.day_number;
Seconds calendar.day_duration;
Out-File : text io.file_type;

begin

-- are there some files in the buffer
if (NumberInList > 0) and (HeadPtr /- null) then

-- what is the time for a unique file name
calendar.split(

date => calendar.clock,
year -> Year,
Month => Month,
Day -> Day,
Seconds => Seconds);

-- use the seconds to create a unique file name
File Name :- new string'("SYS$LOGIN:STARS BROWSER-" &

integer'image(integer(Seconds)) & ".TXT");

-- create the file
text io.create(

file => Out File,
Mode => text io.out file,
name => File-Name.aTl);

-- prolog the file
text io.put(Out File,"This is the list of files/directories that you");
text-io.put lini(Out File," chose from a ");
text-io.putTout_File-,"STARS BROWSER session on ");
text-io.put(Out Fileintege-'image(Month));
text-io.put(Out-File, "/");
text-io.put(Out-Fileinteger'image(Day));
text io.put(OutFile,"/");
text-io.put(Out-Fileinteger'image(Year));
text-io.put_line(Out File,".");
text-io.new line(Out-File,3);

-- load the file with the buffer
while Current Ptr /- null loop

text io.putline(Out File,CurrentPtr.Line.all);
text-io.new line(Out-File);
Current Ptr := CurrentPtr.Next;

end loop;

textio.close(OutFile);

text io.new line(13);
text-io.put line("Your buffer is being written to the file named:");
text io.put line(" & FileName.all);
text-io.new line(ll);
Delay 3.0; -

end if;

end Write Buffer;



procedure Choose Option
Buffer- : in string;
Number Of Choices : in natural;
Choice- - : out natural;
Buffer Status : out boolean) is

--I Description-
This routine gives the integer value of the user choice

-- I

Temp Choice : integer;
Length : natural;
IntegerChoice : integer;

begin
begin

-- looking for an integer
BrowserTypes.int_io.get (Buffer, Integer_Choice, Length);

exception
when others =>

-- integer within range not entered
declare

package Flt _o is new text io.float io (float);
Float Choice : float;
begin

-- was a float entered?
flt-io.get (Buffer, FloatChoice, Length);
-- convert float to integer
Integer Choice :- integer (FloatChoice);
exception

when others =>
-- nothing meaningful entered

IntegerChoice :- 0;
end;

end;

Temp_Choice := Integer_Choice;

if not (TempChoice <- NumberOfChoices and TempChoice > 0) then
BufferStatus false;

else
Buffer Status true;

end if; -

Choice := TempChoice;
end ChooseOption;

Procedure Add (File Name : in Browser_Types.String_Access_Type) is
-- I Description

This procedure adds a single filename to linked list.
-- I
CurrentPtr : BrowserTypes.MenuList_Type;

Oegin
-- when head ptr is null - put the filename in the first cell
if Head Ptr - null then

Current Ptr := new Browser Types.Menu Line Type;
Current -Ptr.Line:- new string'TFileName.all);
Current Ptr.Next := null;



Head Ptr :- Current Ptr;
Back-Ptr : Head Ptr;

-- else put the file name at the end of the list
else

Current Ptr new Browser Types.Menu LineType;
Current-Ptr.Line :- new string'TFileName.all);
Current-Ptr.Next :- null;
Back Ptr.Next Current Ptr;
Back Ptr CurrentPtr;

end if;

-- Add one to the number in the list
NumberInList :- NumberInList + 1;

-- is this the longest one
if Longest line < Current Ptr.Line.all'length then

if CurrentPtr.Line.all'length > Browser Types.DisplayWidth then
Longest-Line :- Browser_Types.DisplayWidth;

else
Longest-line CurrentPtr.Line.all'length;

end if;
end if;

end Add;

procedure Add To Extract Buffer(
-Bfuffer : in out string;
Menu Used : in Browser_Types.MenuListType;
Displayed : in natural;
VirtualPath : in BrowserTypes.String_Access_Type) is

W-I Description
This procedure calls the add routine to add a range of file names to the

--I linked list (ie buffer).
-- I I

Temp_Choice-l : natural 0;
Temp_Choice_2 :natural := 0;

Skip : natural := 0;
Buffer Status : boolean := true;
Menu Ptr : BrowserTypes.Menu ListType :- MenuUsed;
File Name Browser Types.StringAccessType;
Virt File Name Browser Types.String_Access_Type;
Index natural-:= 1;
Temp String : Browser Types.StringAccessType;
VertIcal_Spacing integer-:= 0;

begin

-- remove blanks
Temp_String := new string'(

StringUtilities.RemoveLeadingAndTrailing_Blanks(Buffer));

Buffer(l..Temp_String.all'last) := TempString.all;

-- find a '-' for a range of text
Skip :- String_Utilities.SkipUntil(Buffer,'-');

*- Range of extractions
if Skip > 0 then

-- extract choice from buffer
ChooseOption(

Buffer a> Buffer(4..(Skip - 1)),
NumberOf Choices => Displayed,



-- verify if buffer choice was in the displayed yet.
if Buffer Status - true then

-- get the file from the Menu ListType
for i in 1..(TempChoice 1 - I) loop

Menu Ptr :- MenuPtr.Next;
end loop;

-- store the file name
File Name :=

new string'(String Utilities.Full File Name(Menu Ptr.Line.all));
VirtFileName :- new string'(VirtualPatE.all & File_Name.all);

Add(Virt FileName);

text io.new line(12);
textio.putline(FileName.all & " added to buffer.");
text io.new line(12);
delay 2.0;
text io.new line(12);

end if;
end if;

-- buffer choice was not valid
if Buffer Status = false then

Temp_String := new
string'(StringUtilities.RemoveLeading_And_Trailing_Blanks(Buffer));

text io.new line(12);
text io.put("Sorry... " & Temp String.all);

* text io.put line(" is not a valia command.");
text io.put-line("Type HELP for an explaination of the valid commands.");
text io.new line(12);
delay 2.0; -
text io.new line(12);

end if;

end AddTo extractBuffer;

Procedure Delete (EntryNum : in Natural;
Last-Current : in out BrowserTypes.MenuListType ) is--J Description

This procedure will delete a link from the buffer.
-- i

TempBack : Browser_Types.Menu ListType := Head Ptr;
CurrentPtr : Browser_Types.Menu-ListType := HeadPtr;

begin

for i in l..(Entry Num - 1) loop
TempBack :- Current Ptr;
Current Ptr := CurrentPtr.Next;

end loop; -. if Current Ptr a Last Current then
if Number In List = 1 then

Head Ptr := Null;
Back Ptr := Head Ptr;

else
if Current Ptr Head Ptr then



Choice => TempChoice 1,
BufferStatus => BufferStatus);

if Buffer Status - true then
Choose-Option(

Buffer -> Buffer((Skip + l)..Buffer'last),
Number Of Choices => Displayed,
Choice- - => TempChoice 2,
BufferStatus => Buffer Status);end if;-

if Buffer Status = true then
if TempChoice_2 >= Temp_Choice_1 then

if (Temp Choice 2 - Temp_Choice_1) > 18 then
Vertical_Spacing := 1;

else
Vertical_Spacing := (Browser Types.Display Height -

(Temp_Choice_2 - Temp_ChoTce_1) - 4) / ;
end if;

for i in l..(TempChoice 1 - 1) loop
MenuPtr := Menu Ptr.Next;

end loop;

-- store the file name
FileName :=

new string'(String Utilities.Full File Name(Menu Ptr.Line.all));
VirtFileName :- new string'(Virtual_Path.all & FileName.all);

text io.new line(text io.count (Vertical_Spacing + 8));
Add(Virt File Name); -

textio.put_line(FileName.all & " added to buffer.");

for i in l..(Temp_Choice_2 - Temp_Choice_l) loop

Menu Ptr := MenuPtr.Next;

-- store the file name
File Name :=

new string'(String Utilities.Full File Name(Menu Ptr.Line.all));
Virt FileName :- new string'(VirtualPatE.all & File Name.all);

Add(Virt FileName);

text_io.put line(FileName.all & " added to buffer.");

end loop;

text io.new line (text io.count (Vertical_Spacing));
delay 2.0;

else
Buffer Status :- false;

end if;

end if;
else

-- extract choice from buffer
ChooseOption(

Buffer => Buffer(4..Buffer'last),
Number Of Choices n Pi-r1]v-,
Choice => Tem i (i ,ice 1,
BDffer Status => BufferStatus);



HeadPtr := HeadPtr.Next;
Last Current :- Head Ptr;

elsif Current Ptr - Bac1R Ptr then
Back Ptr :- TempBack;
LastCurrent :- BackPtr;

else
TempBack.next :- CurrentPtr.next;

end if;
end if;

else
if Number In List = I then

Head Ptr := Null;
BackPtr HeadPtr;

else
if Current Ptr - Head Ptr then
Head Ptr := HeadPtr.Next;

elsif Current Ptr = Back Ptr then
Back Ptr :- Temp_Back;
BackPtr.Next null;

else
Temp_Back.next := CurrentPtr.next;

end if;
end if;

end if;

-- Subtract one to the number in the list
NumberInList :- NumberIn List - 1;

-- If buffer if empty, zero the longest line
if Number In List = 0 then

Longest-Line := 0;
end if;

nd Delete;

procedure Delete From Extract Buffer(
Buffer in string;
Last Current in out BrowserTynes.Menu List_Type;
Displayed in natural) is

-- I Description

This procedure calls the delete routine to delete a link from the list.
-- I
Temp Choice : natural := 0;
Buffer Status : boolean := true;
Temp_String : Browser_Types.String_Access_Type;

begin

-- extract choice from buffer
Choose_Option(

Buffer => Buffer(4..Buffer'last),
Number Of Choices => Displayed,
Choice => TempChoice,
BufferStatus => BufferStatus);

-- verify if buffer choice was in the displayed yet.
f Bufer Status - true then

Delete(
Entry_Num => Temp_Choice,
Lastcut b-e =c e w art rnroe nvt)

-- buffer choice was not valid



else
Temp String := new

string,(StringUtilities.RemoveLeading_AndTrailing_Blanks(Buffer));

text io.new line(12);
text io.putT"Sorry... " & Temp String.all);

* text-io.put line(" is not a vali3 command.");
text-io.put-line("Type HELP for an explaination of the valid commands.");
text io.new line(12);
delay 2.0;
text io.new line(12);

end if;
end Delete From Extract Buffer;

procedure Add Entry_ToExtractBuffer is
-- I Description
-- I This procedure adds a user entry to the list from the key board
-- I and not from the list of files.
-- it

Buffer : String (1..256) := (others => '

Length : natural;
Temp Buffer : Browser_Types.StringAccessType;
BufferProblem : Boolean := False;

begin

text io.new line;
text-io.put("New Entry => ");

. begin
text io.getline (Buffer, Length);
exception

when others =>
Buffer Problem := true;

end;

If Buffer Problem then
text io.new line(12);
text-io.putline(" Sorry ... Only 256 Characters Please.");
text io.new line(12);
delay 2.0;
text io.new line(12);

else
Temp_Buffer :- new

string'(String_'tilities.RemoveLeading_AndTrailing_Blanks(Buffer));

Add(TempBuffer);
end if;

end Add_EntryToExtractBuffer;

procedure Clear Buffer( Last Current : in out BrowserTypes.MenuListType) is
-- I Description

This procedure clears the users buffer.

Buffer : string (1..80) := (others => I

Length : natural;

begin



-- exit the menu
elsif Buffer(l) = 'X' then

Repeat Screen := False;
More := false;
text io.new line(l);

-- delete entry
elsif Buffer(l..2) = "DE" then

Delete From Extract Buffer(
Buffer - ->-Buffer,
Last Current -> Last Current,
Displayed => Displayed);

if Number In List = 0 then
More :=-false;

else
RepeatScreen := true;
More := true;

end if;
text io.newline(l);

-- add entry
elsif Buffer(l..2) = "AE" then
AddEntry To Extract Buffer;
Repeat_Screen := true;
More := true;
text io.new line(l);

-- clear buffer
elsif Buffer(l..2) = "CB" then

Clear Buffer(LastCurrent => Last Current);
if Number In List-= 0 then

More false;
else

More True;
RepeatScreen := True;

end if;
text io.new line(l);

-- print help screen
elsif Buffer(l..4) = "HELP" then

Help_Extract;
RepeatScreen := true;
More := true;

-- exit the browser
elsif Buffer(l..4) = "EXIT" then

Write Buffer;
Machine_Ops.DoCommand(Status,"$");

else
-- get integer value
Choose_Option (Buffer,

Displayed,
Choice,
BufferStatus);

-- user entered invalid command
if BufferStatus - false then

-- user entered invalid command
text io.new line(12);
text io.put-line(Buffer(l..length) & " is not valid.");
text-io.put-line("Type HELP for a list of valid commands.");
text io.new line(12);



text io.new line;
text io.putT"Are You Sure You Want To Clear This Buffer (y) :");
text-io.getline (Buffer, Length);

*f (Buffer(l) = ' ') or (Buffer(l) = 'y') or (Buffer(l) - 'Y') then
Head Ptr := Null;
Back Ptr := Head Ptr;
Last Current := ReadPtr;
Number In List := 0;
Longest_ Lne := 0;

end if;

end ClearBuffer;

procedure Get MenuValue ( Choice : out natural) is
-- I Description

This procedure will display a menu with the given title,
all of which is centered on the screen. A prompt will be
given to the user to enter a choice. If an illegal choice
is entered, the menu will be redrawn and the prompt will
be repeated. Control will return only when a legal value
is entered.

VerticalSpacing : integer := 0;
Lines : boolean := true;
More : boolean := true;
Current : Browser Types.Menu ListType :- Head Ptr;
Last Current : Browser Types.MenuListType HeadPtr;

O Repeat Screen : boolean false;
Index : natural 0;
Displayed : natural 0;
Last Displayed : natural 0;
Buffer : string(l..BrowserTypes.displaywidth) :-

(others -> ' )-
Number In List Title : BrowserTypes.StringAccess_Type;
Title Spacing : integer;
Choice Title_Spacing : integer;
Buffer-Status : boolean;
Temp Number Of Choices : natural := NumberInList;
Length : natural;
Title : BrowserTypes.String Access Type :-

new string'("Select Buffer");
Buffer Empty : String(l..16) :- "Buffer is Empty.";
Status : BrowserTypes.Cond ValueType;

begin --get_menuvalue

-- preset Choice to zero
Choice :- 0;

-- display the menu
while More loop

if Current = null then
Last Current :- Head Ptr;
Current :- Head Ptr;
Displayed :- 0;
LastDisplayed := 0;

end if;

-- reset the last page after a help screen



if RepeatScreen then

Current :- Last Current;
Displayed :- Last Displayed;
RepeatScreen :- -alse;

-- determine vertical spacing between title and menu and then menu
-- and prompt
if Number In List > 18 then

Vertical_Spacing := 1;
else

Vertical_Spacing := (BrowserTypes.Display Height -
NumberInList - 4) / 2;end if;

text io.new line(12);
-- if there-will be more than one screen, tell user how many
-- entries
if (Displayed <= 1) then

-- put the title out
TitleSpacing := (BrowserTypes.Display Width -

Title.all'length) / 2;
text io.set col (text io.positive count (TitleSpacing));
text-io.put-line (Title.all);

if Number In List > 18 then
Number In List Title :- new string'("(" &

Tnteger'Tmage(Number In List) & " Items.)");
Choice Title Spacing := (BrowserTypes.Display_Width -

Number In List Title.all'length) / 2;
text io.set col (text io.positive count

(Choice TitleSpacing));
textio.put line (Number In List Title.all);

end if;

end if;

textio.newline (textio.count (Vertical_Spacing));

else
Last Current := Current;
Last-Displayed := Displayed;

text io.new line(12);

-- put the title out
Title_Spacing := (BrowserTypes.Display Width -

Title.all'length) / 2;
text io set col (text io.positivecount (Title_Spacing));
text-io.put-line (Title.all);

-- determine vertical spacing between title and menu and then menu
-- and prompt
if Number In List > 18 then

Vertical_Spacing := 1;
else

Vertical_Spacing := (BrowserTypes.Display Height -
NumberIn List - 4) / 2;O end if;--

-- if there will be more than one screen, tell user how many
-- entries
if Number In List > 18 then

Number In List Title :- new string'("(" &
integer'image(Number In List) & " Items.)");



Choice Title Spacing := (Browser Types.DisplayWidth -
Number In List Title.all'length)-/ 2;
text io.set col (text io.positive count (ChoiceTitleSpacing));
text io.put-line (NumlerInListTitle.all); -

end if;

textio.newline (textio.count (VerticalSpacing));

end if;

if Current = null then
text io.set col(text io.positive count(

((BrowserTypes.DisplayWidth 2) - Buffer Empty'length)/2));
textio.put line(Buffer_Empty);

else
Index 0;
Lines True;

while Lines and (Index <= (BrowserTypes.Display_Height - 7)) Loop
Index := Index + 1;

begin
-- set column for longest menu line
text io.set col(text io.positive count(

((Browser-Types.Display_Width T 2) - LongestLine) / 2));

-- line up the menu choices better
if (Displayed + Index) in 1..9 then

text io.put(' ' & natural'image(Displayed + Index));
else

text io.put(natural'image(Displayed + Index));
end if;

text io.put(" ");
text io.put line (Current.Line.all);
Current := Current.Next;
if Current - null then

Lines := false;
end if;

exception
when others =>

Lines := false;
end;
end Loop; -- lines

Displayed Displayed + Index;

end if;

text io.new line (text io.count (Vertical Spacing));

text io.put( "[ DE # (Delete Entry), AE (AddEntry),");
text -io.putline(" CB (ClearBuf er), X (Prey_Menu), HELP ]");
text io.put("=> ");

text io.get line (Buffer, Length);

-- convert to upper case
Buffer := StringUtilities.ToUpper(Buffer);

-- does the user want to continue the menu
if Buffer(l) = ' I then
RepeatScreen := False;
More := true;
text io.new line(l);



delay(2.0);

-- recursive call to getmenu value
Get MenuValue (Choice);

end if;
More :- false;

end if;

Buffer(l..Buffer'last) :- (others-> '

end loop; -- more loop

exception
when others =>

null;

end GetMenuValue;

procedure Extract Control is
--I Description
-- I This is the procedure that presents a user interface for extract buffer
--I operations (other than the add to extract buffer which is called from the
-- I browser menu.
-- I
Title : BrowserTypes.String_Access_Type :- new string'("Select Buffer");
Choice : natural-:= 0;

begin

* xtract : loop

--Display and get menu value
text io.new line(l); -- to make a clean screen
GetMenuValue( Choice -> Choice);

exit Extract when Choice = 0;
end loop Extract;

text io.new line(24);

end Extract Control;

end ExtractOps;



with BrowserTypes;

package Menu_Ops is

.- Description
This package contains the visible operations on the object Menu.

-- II
Requirements Satisfied

-- I This package does not meet any specific STARS requirements.
--- I

-- I Exceptions Raised

--j None.

-- I Contact
-- I Charles Elsner
--j Boeing Military Airplane
-- I 3801 S. Oliver (ms K80-13)
-- I Wichita, KS 67277

Implementation Dependencies and Assumptions:
Currently, this package uses some of the predefined types from package

-- I Standard.

-- ~ Revision History
-- ~ Part Number:
-- ~ Author: Charles Elsner
-- I Version: 1.0;

@1 Change Summary: InitialRelease
Date: 20-FEB-89

--- I
-- I Distribution and Copyright
-- I This Prologue must be included in all copies of this software.

This software is released to the Ada community.
-- I This software is released to the Public Domain (Note: software released
-- I to the Public Domain is not subject to copyright protection).

Restrictions on use or distribution: NONE

-- I Disclaimer
-- I This software and its documentation are provided "AS IS" and

without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for

a particular purpose is offered. The user is advised to test
-- Ithe software thoroughly before relying on it. The user

must assume the entire risk and liability of using the software.

--I In no event shall any person or organization of people be
held responsible for any direct, indirect, consequential
or inconsequential damages or lost profits.

-- 11

procedure Help_Screen;
-- Description

Display the help screen.
-- I



procedure ChooseOption (
Buffer : in string;
Number Of Choices : natural;
Choice : out integer;
Buffer Status : out boolean);* -- I Description

-- I This routine will determine the integer value choice from the string
--I buffer.
-- I I

procedure Get Menu Value
Menu Used - : in BrowserTypes.MenuList_Type;
Number Of Choices : in natural;
Longest_MenuLine : in natural;
Title . in BrowserTypes.StringAccess_Type;
VirtualPath : in Browser Types.StringAccess_Type;
Choice : out integer);

--I Description
-- I This routine will display a menu to the user, which is a linked list
-- I of all the files in a directory, gets a response fro the user and
-- I passes the reponse to the calling unit.
-- I I

end Menu_Ops;



with Browser Types;
use Browser-Types; -- Using this package to gain visibility to the type

-- declaration operations only;with MachineOps;

ith Extract Ops;
With StringUtilities;

with TextIo;

package body Menu Ops is
-- Description

This package contains the hidden operations on the object Menu.
--- I

Requirements Satisfied
-- I This package does not meet any specific STARS requirements.

--- II
Exceptions Raised

--J None.
--- II
-- I Contact
-- I Charles Elsner

Boeing Military Airplane
-- I 3801 S. Oliver (ms K80-13)
-- I Wichita, KS 67277

--- II
--f Implementation Dependencies and Assumptions:

Currently, this package uses some of the predefined types from package
-- Standard.

@- Revision History
Part Number:
Author: Charles Elsner

-- I Version: 1.0;
-- Change Summary: Initial Release

Date: 20-FEB-89
--- I
-- Distribution and Copyright
-- I This Prologue must be included in all copies of this software.

This software is released to the Ada community.
This software is released to the Public Domain (Note: software released

--I to the Public Domain is not subject to copyright protection).
-- f Restrictions on use or distribution: NONE

-- I Disclaimer
This software and its documentation are provided "AS IS" and

--I without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for

a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user

must assume the entire risk and liability of using the software.

In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential
--j or inconsequential damages or lost profits.



use text io;
proqedure HelpScreen is
--j Description

Display the help screen.

Buffer : string (1..80);
Length : natural;

begin
-- all of these io routines are from the Text Io package
newpage;
put line("HELP - ");
put line(" This Directory Bowser allows users to examine directories");
put line(" and files available on the STARS Repository. Note: These");
put line(" files have not passed the acceptance criteria.");
put line(" The commands available are:");
new-line;
put line(" # - The user chooses a number displayed on the current");
put-line(" menu. If the number corresponds to a Directory (ex.");
put line(" Math Lib.dir), a new menu will be entered which");
put line(" displays the files in that directory. The Directory");
put line(" structure can be likened to a directed graph. The");
put line(" user descends by typing the menu number of a directory,");
put line(" and ascends by typing 'x'. If the user chooses");
put line(" a number which corresponds to a file (ex. SIN.ADA),");
put line(" control will be moved to an editing session for ");
put line(" that file. The current editor is the TPU editor");
put line(" in READ ONLY mode. To get help in this editor, just");
put line(" type help at the command line, (the command line for");
put-line(" VAX Terminals is the DO key.) All floating point ");

* putline(" numbers entered will be truncated.");new-line;

putT"press RETURN for more help");
get line (Buffer, Length);
new line;
new line;
new line;
new line;
put line(" SE # - This is the SELECT command. You can write the");
put line(" file name you choose to a buffer. (ex. SE 1, will");
put line(" write the file name at the menu option 1 to a ");
put line(" buffer.) You may specify a range of files by placing");
put-line(" a '-' between your range. (ex. SE 1-5, will write the");
put-line(" file names from menu options 1 through 5 to a buffer.");
put line(" SELECT records the file name ONLY. To review your");
put-line(" buffer, use the R(EVIEW) command. To obtain a copy");
put-line(" of the selected repository files, the user must use the");
put-line(" 'User Request' option available on the STARS Repository");
put line(" menu.");
new line;
put-line(" REVIEW - This will review your SELECTion buffer, (the ");
put line(" files you have selected from the menus that you wish ");
put-line(" to reuse). As you exit this Browser Session, your buffer");
put-line(" will automatically be written to your directory. The ");
put line(" file name will be STARS BROWSER current-time.TXT. You");
put line(" should use this file to-help you remember what units");
put line(" you want to reuse. If your Buffer is empty, nothing");
put line(" will be written to file.");
new-line;
putT"press RETURN to continue");
get line (Buffer, Length);
new line;
new line;
new-line;



new line;
putline(" X - This will exit the current &aenu screen and display the");
put-line(" previous menu.");
new-line;
put-line(" RETURN - This will either display the next screen in a");
put line(" large menu, or it will redisplay the current menu.");
new-line;
put-line(" HELP - This command can be entered any time. This screen ");
put-line(" will appear as a result of the help command.");
new-:.ne;
put-line(" EXIT or ctrl-z - To exit the Browser Session, type EXIT");
put line(" or ctrl-z at the prompt. Exit will write your Select");
put-line(" Buffer to file, ctrl-z will not.");
new line;
put line(" MENU - This command will go to first Browser menu.");
new line;
put-line(" VMS - This will exit the Browser and place you into the VMS");
put-line(" directory you were browsing. Once in the VMS directory,");
put-line(" you can do any normal VMS operations. Type 'X' to return");
put-line(" to the browser.");
new line;
putT"press RETURN to continue");
get line (Buffer, Length);
newpage;

end Help_Screen;

procedure Choose_Option
Buffer : in string;
Number Of Choices : natural;
Choice : out integer;
Buffer Status : out boolean) is

-- I Description
This routine will determine the integer value choice from the string

-- I buffer.
-- II

TempChoice : integer;
Length : natural;
Integer Choice : integer;

begin
begin

-- looking for an integer
BrowserTypes.intio.get (Buffer, IntegerChoice, Length);

exception
when others =>

-- integer within range not entered
declare

package Flt Io is new textio.float_io (float);
Float Choice : float;
begin

-- was a float entered?
flt io.get (Buffer, Float Choice, Length);
-- convert float to integer
Integer Choice := integer (FloatChoice);
exception

when others =>
-- nothing meaningful entered

Integer Choice := 0;
end;

end;



Temp_Choice := Integer_Choice;

-- did you find a valid integer.
if not (TempChoice <- NumberOfChoices and Temp_Choice > 0) then

* BufferStatus := false;
else

Buffer Status true;
end if;

Choice :- Temp_Choice;

end Choose_Option;

procedure Get Menu Value
Menu Used : in Browser Types.MenuListType;
Number Of Choices : in natural;
Longest Menu Line : in natural;
Title : in Browser_Types.String_Access_Type;
VirtualPath : in BrowserTypes.String_AccessType;
Choice : out integer) is

--j Description
--j This procedure will display a menu with the given title
-- I (all of which is centered on the screen). A prompt will be
-- I given to the user to enter a ch.oice. If an illegal choice
-- I is entered, the menu will be redrawn and the prompt will

be repeated. Control will return only when a legal value
-- I is entered.
-- II

VerticalSpacing : integer := 0;
Lines : boolean true;
More : boolean := true;
Current : Browser Types.Menu ListType := Menu Used;
Last Current : BrowserTypes.MenuListType :- MenuUsed;
Repeat_Screen : boolean :- false;
Index : natural := 0;
Displayed : natural := 0;
Last Displayed : natural : 0;
Buffer : string(l..BrowserTypes.displaywidth) :-

(others => 1 ');
Number Of ChoicesTitle : BrowserTypes.String_Access_Type;
Title Spacing : integer;
Choice Title Spacing : integer;
Buffer-Status : boolean;
Temp Numberof Choices : natural :- Number ofChoices;
Length : natural;
Status : Browser_Types.Cond_Value_Type;

begin --getmenuvalue

-- prepare title for number of choices the user will have
Number Of Choices Title := new string'("(" &

intege?'image(NumberOfChoices) & " Choices.)");

if LongestMenu Line > BrowserTypes.Display_Width then
raise Browser Types.MenuToWide;

end if;

-- determine vertical spacing between title and menu and then menu
-- and prompt
if Number Of Choices > 18 then
Vertical Spacing :- 1;

else



Vertical Spacing :- (Browser Types.Display Height -
NumberO1 Choices - 4) / 2;

end if;

text io.new line(24);

-- put the title out
Title Spacing :- (BrowserTypes.Display Width - title.all'length) / 2;
Choice TitleSpacing :- (Browser Types.Display Width -

Number 0f Choices Title.all'length) / 2;
text io.set col (text io.positve-count (Title_Spacing));
text-io.put-line (Title.all);

-- if there will be more than one screen of choices, tell user how many
if Number Of Choices > 18 then

text To.set col (text io.positive count (Choice Title_Spacing));
text-io.put-line (NumberOfChoicesTitle.all);

end if;

textio.new line (textio.count (Vertical Spacing));

--preset choice to zero
Choice := 0;

-- display the menu
while More loop

-- reset thp last page after a help screen
if Repeat_Screen then

Current := Last Current;
Displayed := Last Displayed;
RepeatScreen := false;
Lines := true;
text io.set col (text io.positive count (Title_Spaci: ));
text io.put line (Title.all);
if (Displayid <= 1) and (Number Of Choices > 18) then

text io.set col (text io.pos'lti~e count (ChoiceTitleSpacing));
text io.put-line (Number_Of_ChoicesTitle.all);

end if;
text io.new line (textio.count (VerticalSpacing));

else
Last Current := Current;
LastDisplayed := Displayed;

end if;

Index := 0;
Lines :- True;

while Lines and (Index <- (B:owserTypes.Display_Height - 7)) Loop
Index :- Index + 1;

begin
-- set column for longest menu line
text io.set col(text io.positive count(

T(Browser_Types.Display_WidtH + 2)-LongestMenuLine)/2));

-- line up the menu choices better
if (Displayed + Index) in 1..9 then

text-io.put(' ' & natural'image(Displayed + Index));
else

text io.put(natural'image(Displayed + Index));
end if;

text io.put(" ");
text io.put line (Current.Line.all);
Current :- Current.Next;



if Current - null then
Lines := false;

end if;

exception
when others ->

Lines :- false;
end;

end Loop;

Displayed := Displayed + Index;

-- output prompt
begin

text io.new-line (text io.count (VerticalSpacing));
exceptlon
when constraint-error =>

null;
end;

text io.put( "[ X (Previous Menu), # (Menu Select), ");
text-io.putline("SE # (Select No.),R(EVIEW Buffer), HELP 1");
text-io.put( "[ hit RETURN (continue), VMS (exit to VMS), ");
text-io.put("MENU (Ist menu)] Command -> ");

text_io.getline (Buffer, Length);

-- convert to upper case
Buffer := String_Utilities.ToUpper(Buffer);

-- does the user want to continue the menu
if (Buffer(l) = ' ') and (Displayed < Number Of Choices) then
More := true;
RepeatScreen false;

-- exit the menu
elsif Buffer(l) = 'X' then

More :- false;

-- exit the browser
elsif Buffer(l..4) = "EXIT" then

text io.new line(24);
ExtractOps.Write Buffer;
MachineOps.DoCommand(Status,"$");

-- select some menu options for the buffer
elsif Buffer(l..2) = "SE" then

Extract Ops.Add To Extract Buffer(
Buffer => Buffer,
Menu Used => Menu Used,
Displayed => Number Of Choices,
Virtual Path => Virtual Path);

RepeatScreen := true;
More := true;

-- help screen
elsif Buffer(1) = 'H' then

Help_Screen;
RepedtScreen := true;
More := true;

-- exit to vms
elsif Buffer(l..3) - "VMS" then
Machine_Ops.Spawn(Status,"@geech$duaO:[stars utilities]vms.com " &

Virtual path.all);
RepeatScreen := true;



More := true;

-- goto first menu
elsif Buffer(l..4) - "MENU" then

Repeat Screen :- false;
More :- false;
Choice :- -1;

review the users buffer of selected items
elsif Buffer(l) = 'R' then

Extract ops.Extract Control;
RepeatScreen :- true;
More :- true;

else
-- get an integer from the users entry
ChooseOption (Buffer,

Temp Number_Of_Choices,
Choice,
Buffer Status);

if BufferStatus = faTse then

-- user entered invalid command (except for '

if Buffer(l) /- I ' then
text io.new line(12);
text-io.put-line("'" &Buffer(l..length)& "'" &

" is not valid.");

text io.put line("Type HELP for a list of valid commands.");
text-io.new-line(12);
delay(2.0);
-- repeat this screen
Repeat Screen := true;
More := true;

O else
-- recursive call to get menu value

Get Menu Value (MenuUses,
Number Of Choices,
LongestMenuLine,
Title,
Virtual Path,
Choice);

-- found a valid command, so don't loop anymore
More := false;

end if;

else
-- found a valid command, so don't loop anymore
More := fal;

end if;

end if;

-- reset the buffer for next command
Buffer(l..Buffer'last) :- (others => '

end loop; -- more loop

exception
when others =>. null; -- Do not bomb out ... go gracefully.

end GetMenuValue;

end MenuOps;



with text io;
with StriNg Utilities;
with ConditionHandling;
with Lib;

* ckage BrowserOps is

-- I Description
--I This package contains the visible operations on the object Directory

Browser.

m--

Requirements Satisfied
This package does not meet any specific STARS requirements.

Exceptions Raised

-- I None.

-- I uontact
Charles Elsner
Boeing Military Airplane

-- I 3801 S. Oliver (ms K80-13)
-- I Wichita, KS 67277

Implementation Dependencies and Assumptions:
-- I Currently, this package uses some of the predefined types from package
-- I Standard.

@- Revision History
Part Number:
Author: Charles Elsner
Version: 1.0;

--I Change Summary: InitialRelease
-- I Date: 20-FEB-89

Distribution and Copyright
-- I This Prologue must be included in all copies of this software.

This software is released to the Ada community.
This software is released to the Public Domain (Note: software released

-- I to the Public Domain is not subject to copyright protection).
Restrictions on use or distribution: NONE

Disclaimer
This software and its documentation are provided "AS IS" and
without any expressed or implied warranties whatsoever.

-- No warranties as to performance, merchantability, or fitness
for a particular purpose exists.

Because of the diversity of conditions and hardware under
-- I which this software may be used, no warranty of fitness for

a particular purpose is offered. The user is advised to test
the software thoroughly before relying on it. The user
must assume the entire risk and liability of using the software.

#- In no event shall any person or organization of people be
held responsible for any direct, indirect, consequential
or inconsequential damages or lost profits.

procedure Run Browser(



Menu_1 : in string; -- VMS file name of the first menu
-- I This file must be in top level dir

Menu_1_title : in string; -- Title to be displayed fo? menu-1
Menu_2 : in string; -- VMS file name of the second menu

This file must be in top level dir
Menu 2 Title : in string; Title to be displayed fo? menu-2
Editor-Used : in string; -- Editor to use/plus options
Utility Directory in string; -- I Locale of utility directory
Tp_LevelDir : in string);--I Directory to start browsing.

-- Menu 2 is a directory listing of
this top_level directory.

-- I Description
-- I This is the procedure to start the directory browser menu/interface
-- I tool. Menu 1 is a string to identify the file name of the first menu.
-- I This is an example of the menu_1 menu.

This is the first menu for the stars foundation
-- I project search/view tool. ** Make certain that this file is version 1!

-- (Do not delete these first three lines. Program dependent.)
-- I Review STARS Foundation Projects
-- I Exit to VMS (in Directory ODIE$DUAl28:[STARSFOUNDATION])
-- I Help

or 'X' to Exit (Return to SDME)

-- (Do not delete these last two lines. Program Dependent.)

-- I Menu_2 is just a dir/col-1/output-Menu_2.dat.
-- I

Exceptions Raised
.- None.

ene B'owser_Ops;



with Browser Types;
with Calendar;
with Extract Ops;
with File Ops;
ith Machine Ops;ith Menu Ops;ith String_Utilities;

with TextIo;

package body Browser_Ops is

-- I Description
This package contains the internal operations on the object Directory

--f Browser.

-- ~ Requirements Satisfied
This package does not meet any specific STARS requirements.

-- II
-- ~ Exceptions Raised

-- I None.
--- II
-- I Contact
-- I Charles Elsner
--j Boeing Military Airplane
--f 3801 S. Oliver (ms K80-13)
-- ~ Wichita, KS 67277

Implementation Dependencies and Assumptions:
#Currently, this package uses some of the predefined types from package

Standard.

-- J Revision History
Part Number:
Author: Charles Elsner

-- I Version: 1.0;
-- I Change Summary: Initial Release
-- ~ Date: 20-FEB-89

-- I Distribution and Copyright
-- I This Prologue must be included in all copies of this software.
-- I This software is released to the Ada community.

This software is released to the Public Domain (Note: software released
to the Public Domain is not subject to copyright protection).

Restrictions on use or distribution: NONE

-- I Disclaimer
This software and its documentation are provided "AS IS" and
without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

-- ~ Because of the diversity of conditions and hardware under
*- which this software may be used, no warranty of fitness for

a particular purpose is offered. The user is advised to test
the software thoroughly before relying on it. The user

-- f must assume the entire risk and liability of using the software.

-- f In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential
--j or inconsequential damages or lost profits.



-- Il

ocedure execute-choice

Choice : in integer;

User : in out BrowserTypes.StringAccess Type;
Virtual Path : in out BrowserTypes.String Access-Type;
Title : in out Browser_Types. StringAccess-Type;
Utility Directory : in out BrowserTypes.StringAccessType;
EditorUsed : in out Browser Types.String AccessType;
Ptr : in out Browser Types.Menu_LIst_Type;
GoBack : in out BooleanT is

--I Description
This procedure executes an operation based on the input Choice. The main

-- I operations to be performed are, 1) edit a file, 2) Browse a Directory.
To browse a directory, the procedure uses a recursive call.

-- II

Current : BrowserTypes.Menu ListType := Ptr;
File Type : Browser Types.String AccessType;
File-Name : BrowserTypes.String Access_Type;
Commind : Browser Types.String Access Type;
Menu Head : Browser-Types.Menu_List_Type;
Menu Choices : natural;
Menu Longest natural;
New Choice : integer;
Status : Browser Types.CondValueType;
DataFile : Text_Io.FileType;

*in

-- build Command string

-- is choice a menu option
if Choice > 0 then

-- find the actual line to execute (edit a file or browse a dir)
for i in 1..(Choice - 1) loop

Current := Current.Next;
end loop;

-- find the file type
FileType := new string'(StringUtilities.FileType_Is(Current.Line.all));

-- is file a directory
if File_Type.all = "DIR" then

-- create, open and read data file, then delete it.

-- create a dir/col=l/output-file name.dat
File_Ops.Create_Data_File(

Utility Dir => UtilityDirectory,

File Line => Current.line,
User => User,
VirtualPath > Virtual Path,

4 File => FileName);

-- read the file into a linked list
File_Ops.load_menu_list(

File Name m> File Name.all,
Ptr -> Menu-Head,



Data File -> Data File,
Number Of Choices -> Menu-Choices,
longest imenu line -> MenuLongest);

-- we are done with the file now
TextIo.Delete(DataFile);

-- display menu

-- enter a loop for each virtual Path, displaying the choices
begin
Virtual: loop

-- display the menu and get a user command
Menu Ops.Get MenuValue

TMenu Used -> Menu Head,
Number Of Choices -> Menu-Choices,
longest_minu line -> Menu-Longest,
Title -> Virtual Path,
Virtual Path -> Virtual-Path,
Choice -=> NewChoTce);

-- execute choice

Execute Choice (
Choice => New Choice,
User => User,
Virtual Path => VirtualPath,Title -- => Current~line,

Utility Directory => Utility Directory,
EditorUsed => Editor Used,Ptr -=> Menu Head,

GoBack -> GoBack);

-- exit loop when new choice is 0
exit Virtual when NewChoice = 0;

-- if the user want to go back to main menu
exit Virtual when GoBack;

end loop Virtual;

exception
when others =>

null;

end;

-- back out of the virtual path
Virtual_Path :- new string'(String_Utilities.BackOff(Virtual_Path.all));

else

-- edit the file
File_Ops.EditFile(

Virtual Path => Virtual Path,
Editor => Editor Used,Line => CurrenT.line);

GoBack :- False;

end if;

elsif Choice - 0 then
GoBack :- False;



elsif Choice < 0 then
Go Back :- True;

else
null; -- for future expansion

* d if;

end ExecuteChoice;

procedure Execute Main Choice
C~oice- : in out integer;
Menu 2 : in string;
Virtual Path : in out Browser_Types.StringAccess_Type;
Utility-Directory : in out Browser_Types.StringAccess_Type;
Editor Used : in out Browser_Types.StringAccess_Type;
User : in out BrowserTypes.StringAccessType;
Title : in out Browser_Types.StringAccessType) is

--I Description
-- f This routine will execute the users choice fro the main menu (ie menu_1)
-- I

Command : Browser Types.String Access Type;
Menu Head : Browser Types.Menu LIst_Type;
MenuChoices : natural;
Menu Longest : natural;
New Choice : integer;
Status : Browser Types.CondValueType;
Data File : Text Io.File Type;
GoBack : Boolean := false;

*gin

-- build Command string

case Choice is
when 0 ->

null;

-- browse a directory
when 1 ->

-- open and read from Ptr.line (ie the data file)

File Ops.load menu list
File Name => Menu 2,
Ptr -> Menu Head,
Data File -> Data-File,
Number Of Choices => Menu Choices,
longestmenu line -> MenuLongest);

-- display menu

. -- enter a loop for first Virtual-Path, displaying the Choices

begin
First: loop

MenuOps.GetMenuValue(
Menu Used -> Menu Head,
NumberOfChoices m> Menu-Choices,



longestmenu-line -> Menu Longest,
Title -> Title,
Virtual Path -> Virtual Path,
Choice -> New ChoIce);

--------------- ---------------------------------------------------------

-- execute Choice

ExecuteChoice (
Choice W> New Choice,
User -> User,
Virtual Path -> Virtual Path,
Title -> Menu Head.line,
Utility Directory > Utility Directory,
EditorUsed => Editor Used,
Ptr -> Menu Head,
Go Back -> Go Back);

-- exit loop when New Choice is 0
exit first when NewChoice - 0;

-- user wants to go back to main menu
exit first when Go Back;

end loop first;
exception

when others =>
null;

end;

when 2 =>.Menu_Ops.Help_Screen;
when 3 =>

Choice :- 0;
when others ->

null;
end case;

end Execute Main Choice;

procedure RunBrowser(
Menu 1 : in string;
Menu_ 1Title : in string;
Menu 2 : in string;
Menu 2 Title : in string;
Editor Used : in string;
Utility Directory : in string;
Top_LevelDir : in string) is

-- ( Description
Main call to execute the directory browser routine.

-- II

Main Head : Browser_Types.MenuList_Type;
hoice : integer;

Wumber Of Choices : natural := 0;
longest menu line : natural :- 0;
Virtual-Path- : BrowserTypes.String Access Type :-

new string'(Top Level Dir);
UtilityDir : Browser Types.String Access Type :- new

string'(Utility_Directory);



Editor : Browser_Types.StringAccess-Type :- new
string'(Editor Used);

Data-File : TextIo.File_Type;

#pLevel Title : BrowserTypes.StringAccessType :-
new string'(Menu 1 Title);

econdLevel Title : Browser_Types.StringAccess_Type :-
new striRg'(Menu_2_Title);

Year : calendar.year number;
Month : calendar.montf number;
Day : calendar.day number;
Seconds : calendar.dayduration;
User : Browser_Types.String_Access_Type;

begin

-- Generate Unique user number for file contention prevention.

calendar.split(
date => calendar.clock,
year => Year,
Month => Month,
Day => Day,
Seconds => Seconds);

-- use the seconds to create the users unique number
User :- new string'(Stringutilities.Remove LeadingAnd TrailingBlanks(

integer'image(integer(Seconds))));

*-turn off system messages

-- MachineOps.TurnOff_Mess;

-- open and read from Menu l.dat

FileOps.Load MenuList (
File Name => Menu 1,
Ptr -> Main Head,
Data File => Data File,
Number Of Choices -> Number Of Choices,
longest menuline => longest_menu line);

-- display menu

loop

MenuOps.Get Menu Value(
-Menu Used => Main Head,
Number Of Choices > Number Of Choices,
longesE_menu-line => longesE menu line,
Title - > Top Level TiTle,
Virtual Path -> Virtual Path,
Choice => Choice),

-- execute main Choice



Execute Main Choice (
Choice -> Choice,
Menu 2 > Menu 2,
Virtual Path > Virtual Path,
UtilityDirectory > UtilityDir,
EditorUsed > Editor,
User > User,
Title > SecondLevel Title);

if Choice - 0 then
exit;

end if;

end loop;

-- Write the Extraction Buffer to the user Directory.

Extract_Ops.Write_Buffer;

-- final greeting

text io.new line(24);

-- MachineOps.TurnOnMess;

xception
when others =>

null; -- go gracefully

end Run Browser;

end Browser_Ops;



with BrowserOps;
with Browser-Types;

procedure Browser Driver is
* Description

This procedure calls the Run-Browser procedure.
-- I

Requirements Satisfied
This package does not meet any specific STARS requirements.

--- I

-- IExceptions Raised

None.
--- I
-- I Contact
-- I Charles Elsner
--j Boeing Military Airplane
-- I 3801 S. Oliver (ms K80-13)
--j Wichita, KS 67277
--- I

Implementation Dependencies and Assumptions:
--j Currently, this package uses some of the predefined types from package
-- I Standard.

Revision History
--j Part Number:
-- I Author: Charles Elsner
- Version: 1.0;

Change Summary: Ln.cie' Release
*- Date: 20-FEB-89

--j Distribution and Copyright
-- I This Prologue must be included in all copies of this software.

This software is released to the Ada community.
This software is released to the Public Domain (Note: software released

-- I to the Public Domain is not subject to copyright protection).
-- J Restrictions on use or distribution: NONE

-- I Disclaimer
This software and its documentation are provided "AS IS" and

-- J without any expressed or implied warranties whatsoever.

No warranties as to performance, merchantability, or fitness
-- I for a particular purpose exists.

Because of the diversity of conditions and hardware under
which this software may be used, no warranty of fitness for

-- I a particular purpose is offered. The user is advised to test
-- I the software thoroughly before relying on it. The user

must assume the entire risk and liability of using the software.

In no event shall any person or organization of people be
-- I held responsible for any direct, indirect, consequential
-- I or inconsequential damages or lost profits.

Top level directory that the browser will start at
Top_LevelDir : Browser Types.String AccessType :- new

string'T"ODIE$DUAl28U[STARSFOUNDATION]");

-- Title that will be displayed for menu 1
Menu_1_Title : BrowserTypes.String_AccessType :- new



string'("STARS Foundation");

-- Yath name for first menu
Menu_1 : Browser Types.String Access Type :- new

string'( "geeEh$duaO[starsutilities]found menul.dat;l");

Title that will be displayed for menu 2
Menu 2 Title : Browser Types.String Access Type :- new

string 7 ("STARS Foundation Projects");

-- Path name for second menu
Menu_2 : BrowserTypes.String Access Type :- new

string'( Top_Level_Dir.all & "menu_2.dat;l");

-- editor that the users will use
Editor : BrowserTypes.StringAccessType : new string'("edit/tpu");

-- utility directory where the file operations will take place
Utility_Directory : Browser Types.String Access Type :- new

string'("GEECH$DUAO:[STARSUTILITIES]");

begin
-- call the procedure to start the browser
Browser_Ops.Run Browser(

Menu 1 m> Menu_1.all,
Menu 1 Title -> Menu_1- Title.all,
Menu-2 => Menu 2.all,
Menu-2 Title => Menu-2 Title.all,
Editor Used => Editor.all,
UtilityDirectnry => Utility Directory.all,
Top_LevelDir => Top_LevelDir.all);

*-nd;



$! This is the command file used in the 'escape to vms' function in the
$! directory browser. The file name VMS.COM. '1' is a comment token.

$ ESC[0,8]=27
WS = WRITE SYS$OUTPUT !wLite to screen
SC HOME :- 'ESC'[H !go to upper left part of screen

WCEEAR := 'ESC'[2J !clear screen
$ set nocontrol=y
$ save dir - f$environment("default")
$ set aef 'pl' !pl is the input parameter (dir)
$ WS C HOME,CLEAR

$ WS " * Type 'X' or 'EXIT' to return to the Browser *
$k

$ WS " * Type 'HELP' to invoke VAX/VMS help facility *

$ WS " * Type 'HELPB' to invoke Browser help facility *

$ WS " * Type 'SYMBOLS' to see the VAX/VMS Symbols set up for you *

$ wS I

$ WS "
$ WS " Current Directory:"
$ sho def
$ WS "$1
$ ready:
$ inqcuire/nopuncLudtion next "browser $ "
$ if next .nes. "HELP B" then goto -ot help
$ type geech$duaO:[starsutilities]vms-help.txtqgoto ready

not help:
40 iE next .eqs. "KERMIT" then next = "RKERMIT"
$ if next .eqs. "DONE" then goto isdone
$ if next .eqs. "EXIT" then goto isdone
$ if next .eqs. "QUIT" then goto isdone
$ if next .eqs. "STOP" then goto isdone
$ if next .eqs. "LO" then goto isdone
$ if next .eqs. "LOG" then goto isdone
$ if next .eqs. "LOGOUT" then goto isdone
$ if next .eqs. "LOGOFF" then goto isdone
$ if next .eqs. "MENU" then goto isdone
$ if next .eqs. "BROWSER" then goto isdone
$ if next .eqs. "HOME" then goto homedone
$ if next .eqs. "X" then goto isdone

$ define/user mode/NOLOG sys$input sys$command
$ set control=y
$ on control_y then continue
$ on severe error then continue
$ 'next' !execute the users vms command
$ set nocontrol=y
$ goto ready
$ home done:
$ seE def sys$login
$ goto ready
$ isdone:

set control=y
set def 'save dir' !go hark to irrs oricinal directory
WS C HOME,CLEAR

$ exit- exit this command file


